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C h a p t e r  1

Month-end tasks
month-end procedures;end of month procedures;period-end procedures;accounting periods:period-end procedures

Month-end procedures usually are performed at the end of every month, 
but they can be done at any time during the month. The key to success is to 
perform these tasks regularly. Some tasks need to be performed at a 
specified time every month. Consult your accountant if you�re unsure which 
of these tasks are required for your business.

Reviewing and printing your trial balance
trial balances:reviewing;trial balances:printing;reviewing:trial balances;printing:trial balances;<$nopage>general ledgers:<Emphasis>See<Default Para Font> trial balances and accounts

Reviewing a trial balance report � also known to accountants as a general 
ledger � regularly is an optional month-end task, but it can make your job 
easier in the future. If you regularly review your trial balance, you�ll spot 
incorrectly recorded amounts quickly and will be able to fix them without 
much effort. If you decide to skip this procedure, however, and an error 
appears, you may find yourself sifting through several month�s worth of 
transactions trying to find the one that�s incorrect.

Step by step

�To print a trial balance (or general ledger)� on page 344
�To review your trial balance� on page 345

Adjusting budgets
budgets:reviewing;budgets:adjusting;reviewing:budgets

Reviewing the monthly amounts you�ve budgeted for your accounts will 
help you keep your fingers on the pulse of your business. If you�ve 
determined that changes need to be made to the amounts you�ve budgeted 
for the coming months, you can adjust your budget. 

Step by step

�To change a budgeted amount� on page 346

Month-end tasks - Adjusting budgets
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Reconciling checking accounts
reconciling:accounts;checking accounts:reconciling;accounts:reconciling;statements:reconciling accounts;reconciling:statements;<$nopage>bank statements:<Emphasis>See<Default Para Font> reconciling;checkbook reconcilication<Emphasis>See<Default Para Font> reconciling;reconciliation report:<Emphasis>See<Default Para Font> 

reconciling;bank reconciliation:<Emphasis>See<Default Para Font> reconciling

To ensure the accuracy of your business records, you should keep a record 
of your checking accounts� balances matched up with your bank�s records. 
This task is called reconciling accounts. If this is the first time you�re 
reconciling an account using MYOB BusinessBasics, be sure to see 
�Reconciling an account for the first time� on page 342 for additional 
information.

Once you�re sure all the checks and deposits that appear on your bank 
statement are entered in BusinessBasics, you�re ready to reconcile your 
account.

out of balance:reconconciling accounts;accounts:reconciling:out of balance;reconciling:out of balance

If your account is out of balance, a window will indicate the amount by 
which your account is out of balance, and will provide you with a few ideas 
of how the out-of-balance situation might have occurred.  Here are some 
additional things you might want to verify:

� Are all the checks and deposits that appear on your bank statement 
marked in the Reconcile Accounts window? Check to be sure the deposit 
and withdrawal amounts that appear on the Total Cleared line near the 
bottom of the Reconcile Accounts window are the same as the total 
deposit and withdrawal amounts on your bank statement.

� Did you mistakenly mark a transaction that doesn�t appear on your bank 
statement?

� Did you make the correct entry in the New Statement Balance field? (Be 
sure you entered the ending balance from your statement, not your 
beginning balance.)

� Are all deposits accounted for? If the bank statement shows a higher 
balance than the balance calculated by BusinessBasics, a previously 
cleared deposit may have been deleted and not reentered, or reentered but 
not marked as cleared.

If you decide to exit the Reconcile Accounts window without successfully 
reconciling a checking account, the transactions marked as cleared remain 
marked. You can pick up where you left off at any time.

bank service charges:entering;interest:entering;service charges:entering

If you wish, you can enter bank service charges and interest using the 
Reconcile Accounts window. You�ll click the Bank Entry button to open the 
Record Service Charges and Interest Earned window. If you�ve received 
bank service charges, enter an amount in the Service Charges section. If the 
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account you�re reconciling is a Detail Checking Account, the bank fee, 
when recorded, will appear as a check transaction assigned to the checking 
account you�re reconciling. The next available check ID number is assigned 
to the transaction. (If the account you�re reconciling is a Detail Account, a 
General Journal entry will be recorded.) Verify the date and enter the 
account you wish to allocate the charges to (usually an expense account). 
Add a memo if you wish.

If you received interest, you�ll enter an amount in the Interest Earned 
section. If the account you�re reconciling is a Detail Checking Account, the 
interest, when recorded, will appear as a deposit transaction assigned to the 
checking account you�re reconciling. The next available deposit ID number 
is assigned to the transaction. (If the account you�re reconciling is a Detail 
Account, a General Journal entry will be recorded.) Verify the date and 
enter the account you wish to allocate the bank interest to (usually an 
income account). Add a memo if you wish.

Step by step

�To reconcile an account� on page 351
�To reconcile an account for the first time using BusinessBasics� on 
page 353
�To change tax amounts for a single transaction� on page 35

Reconciling an account for the first time
reconciling:accounts:for the first time;accounts:reconciling:for the first time

When you reconcile an account for the first time using BusinessBasics, 
some of the checks you wrote and some of the deposits you made before 
you began using MYOB BusinessBasics will probably be reflected in your 
bank statement. In order to reconcile the account, these transactions must 
also appear in the Reconcile Accounts window. Because you conducted the 
transactions before you began using BusinessBasics, though, there will be 
no BusinessBasics record of those transactions. This situation must be 
resolved before you can reconcile the checking account.

To resolve the situation, you�ll create a general journal entry. Each 
uncleared check and uncleared deposit you conducted before using 
BusinessBasics should be entered as line items on a general journal entry. 
When you�re ready to reconcile the checking account, each line of the 
general journal entry will appear in the Reconcile Accounts window. 

You�ll enter your checking account in the Acct # column of the General 
Journal window. The individual deposit amounts should be entered in the 
Debit column and the individual check amounts should be entered in the 
Credit column.
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It�s unlikely that the debits will equal the credits in the Record Journal Entry 
window. If there is an out of balance amount, you need to enter another line 
item with an amount that balances the debits and credits.

Since the general journal entry you create debits and credits the checking 
account for the same amount, the journal entry will not affect the balance of 
the checking account. 

Step by step

�To reconcile an account� on page 351
�To reconcile an account for the first time using BusinessBasics� on 
page 353

Printing customer statements
Performing month-end tasks > Printing customer statements

Most businesses send statements of sales activity to their customers at the 
end of each month. See �Printing statements� on page 168 for more 
information. 

Month-end tasks - Printing customer statements

Closing accounting periods
accounting periods:closing;closing:accounting periods

MYOB BusinessBasics doesn�t require you to close accounting periods. The 
things you do to �close� an accounting period are more for the sake of 
keeping track of your periodic business activity, so you have accurate 
historical records to refer to in the future. As a result, the tasks listed below 
are merely suggestions�but they�re suggestions that may help you out a 
great deal someday. 

accounting periods:locking;locking:closed accounting periods

BusinessBasics allows you to �lock� the closed accounting period to 
prevent you from inadvertently making an entry in a month in which you 
don�t want new entries. This �lock� affects the month you select and all 
months before it. If, at a later time, you need to make an entry in a month 
that occurs before the month you selected here, simply change your 
selection here so that month is �unlocked� and available for transaction 
entry again.

Step by step

�To close an accounting period� on page 355
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C h a p t e r  2

Reviewing your trial 
balance
Printing a trial balance (or general ledger)

4 To print a trial balance (or general ledger)
trial balances:printing;printing:trial balances

Related topics

�Reviewing and printing your trial balance� on page 340

The Index to Reports window  should be displayed.

1. Select the Accounts tab to display a scrolling list of reports that are 
associated with the Accounts Command Center.

2. Highlight the Trial Balance (Detail) selection.

3. Click the Customize button. Make account, date and sort selections.

Choose the option Include Accounts with No Activity if you wish to 
display all accounts, even those accounts that have no transactions 
recorded between the beginning and ending dates that have been selected 
for this report. 

4.  Click OK to redisplay the Index to Reports window.

5. Click the Print button.



Chapter 2   Reviewing your trial balance

     MYOB Learning Center 345    

Reviewing your trial balance

4 To review your trial balance
trial balances:reviewing;reviewing:trial balances

Related topics

�Reviewing and printing your trial balance� on page 340

When you review the report, look for: 

� Entries that seem unusually high or low for the account that�s been affected

� Debit amounts for accounts that normally have credit entries, and vice 
versa

� Unusually high or low ending balances

� An unusually high or low number of entries for a specific account
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C h a p t e r  3

Adjusting budgets
 Adjusting budgets

4 To change a budgeted amount
budgets:adjusting

The Accounts List window should be displayed. 

1. Highlight an account you want to change.

2. Click Edit. The Edit Accounts window appears, displaying information 
about the account. 

3. Click the Budgets button to display the History and Budgets window.

4. Make any needed changes to the amounts displayed in the Budget column. 

Remember to enter only the expected change (increase or decrease) in the 
account�s balance; don�t enter the expected balance for the account during 
the month in question. Also be sure to enter a positive amount if you 
expect the account�s balance to rise. Even if the amount represents an 
expense to your company, it should be positive if it causes the account�s 
balance to rise.

5. Click OK. 

6. Click OK in the Edit Accounts window to redisplay the Accounts List 
window. 

7. Select another account if you need to make additional budget changes, or 
click Close if you don�t have any more changes to make.

Related topics 

�Adjusting budgets� on page 340
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C h a p t e r  4

Purging information 
that�s no longer needed

purging:defined;company files:purging information

After you�ve used MYOB BusinessBasics for a long time, you�ll notice that 
the size of your company file has grown considerably. Information such as 
journal entries and invoices build up over time. When your company file 
has grown larger than you want it to, you may want to delete the parts of the 
data that are no longer needed from the file. The process of removing data 
from your company file is called purging. 

purging:recommended order of purging information

Note: Purging is based on your current financial year setup

When you select the month before which you want to purge, 
BusinessBasics checks the current financial year of your company 
file and uses the selected month of your current financial year as the 
basis for deciding which transactions to purge. Before you purge, 
check the current financial year of your company file using the 
Company Information window.

When you purge information from your records, you should plan out a 
strategy to do so. We strongly recommend that you purge your information 
in the following order:

1. Closed invoices

2. Journal entries

Step by step

�To purge closed invoices� on page 348
�To purge journal entries� on page 350

Viewing transactions after purging
purging:viewing purged information;viewing:purged information

If you choose Purge Detail Only when purging sales the detail information 
that was entered in the scrolling list section of the sale will be deleted; 
information, such as, ID number, date, customer name, memo, comment or 
customer purchase order number for each closed sale will remain. The 
zoom arrow that appears before journal entries for these sales will be gray. 
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Click the zoom arrow to display the window in which the original 
transaction was entered -- detail information mentioned above will not 
display. You won�t be able to make any changes to this window.

If you choose Purge Entire Sale, all information about the closed sales will 
be deleted. The journal entry will remain in the Sales Transaction Journal 
window, but no zoom arrow will appear; you�ll no longer be able to display 
the window in which the original transaction was entered. 

If you purged entire closed sales and you wish to also delete the journal 
entries for these closed transactions from the Sales Journal, follow the steps 
for �To purge journal entries� on page 350.

Step by step

�To view purged information in the Sales Journal � if you purged detail 
only� on page 349

Purging closed sales

4 To purge closed invoices
purging:closed invoices;sales:purging closed sales;closed invoices:purging;invoices:purging closed invoices

Related topics

�Purging information that�s no longer needed� on page 347

purging:effects on analysis capabilities 

Warning: Purging information will change the way you view 
your financial activity

Various types of information, including journal entries and closed 
sales transactions, can be deleted from a company file. The 
information you can delete won�t prevent you from keeping accurate 
financial records, but removing some types of information could 
change the way you analyze your information. We suggest you 
carefully consider the results of purging data from your company file 
before you do so. Although you can recover the information from a 
backup copy of the company file, the process may take more time 
and effort than you�re willing to invest.

1. Print all the reports that you wish to keep that show the closed sales you�ll 
be purging. You might consider printing a copy of the Sales & Receivables 
Journal, which contains detailed information about all sales.

2. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records.
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3. Open the Sales Command Center.

4. Choose Purge Closed Invoices from the File menu. The Purge Closed 
Invoices window appears.

5. From the Purge Invoices Close BEFORE list, choose the first month for 
which you don�t want to delete closed invoices. Be especially careful when 
you select a month�don�t include an accounting period that isn�t 
completely closed. All closed invoices dated prior to the month you select 
are marked for purging.

6. Choose to purge detailed information about closed invoices only, or to 
purge entire closed invoices. 

7. Click the Continue button. Another Purge Closed Invoices window 
appears, listing all customers in the Card File.

8. From the list of customers, select the customers whose closed sales you 
want to purge. If you wish to keep closed invoices for any customers, 
remove the x that appears next to each of the customers� names by clicking 
it.

9. Click the Purge Closed Invoices button. The closed invoices for the time 
frame you specified and for the customers you selected in this window will 
be deleted.

4 To view purged information in the Sales Journal 
� if you purged detail only
purging:viewing purged information:using Sales Journal;viewing:purged information:using Sales Journal

Related topics

�Viewing transactions after purging� on page 347

The Transaction Journal window  should be displayed.

1. Use the scroll bar to find the purged sale you want to view.

2. Click the zoom arrow next to the closed invoice to view the original 
window in which the transaction was entered, displaying only the 
information that wasn�t purged.

If you purged entire closed invoices, you won�t be able to view any details 
about the invoice, other than those that appear in the Sales Journal.
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Purging outdated journal entries

4 To purge journal entries
purging:journal entries;journal entries:purging

Related topics

�Purging information that�s no longer needed� on page 347

1. Print all the reports that you wish to keep that show the transactions you�ll 
be purging. Account Transactions reports contain most of the information 
you may want to retain.

2. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records. (If you�ve just purged closed 
sales and made a backup during one of those procedures, it�s not necessary 
to make another backup for journal entries.)

3. Open the Accounts Command Center. 

4. Choose Purge Journal Entries from the File menu to open the Purge 
Journal Entries window.

5. From the Purge Journal Entries BEFORE list, choose the first month for 
which you don�t want to delete journal entries. Be especially careful when 
you select a month�don�t include an accounting period that isn�t 
completely closed. All journal entries dated prior to the month you select 
will be marked for purging.

6. Click the Continue button. Another Purge Journal Entries window will 
appear, listing all the accounts in your accounts list.

7. From the list of accounts, select the accounts whose unreconciled journal 
entries you don�t want to purge. Typically, you should select the accounts 
you regularly reconcile in the Reconcile Accounts window.

Note: This is different than what you do with sales!

Be sure to mark the accounts that have unreconciled journal entries 
you don�t want to be deleted. (Don�t make the mistake of marking 
the accounts you do want to be deleted as you do with sales.) Be 
careful when you make your selections!

8. Click the Purge Journal Entries button. The journal entries for the time 
frame you specified and for the accounts you didn�t select in this window 
will be purged. 
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C h a p t e r  5

Reconciling accounts
Reconciling accounts

4 To reconcile an account
reconciling:accounts;accounts:reconciling;checking accounts:reconciling;statements:reconciling accounts;reconciling:statements

Related topics 

�Reconciling checking accounts� on page 341

The Reconcile Accounts window  should be displayed.

Note: If you�re reconciling for the first time

If you�ve never used the Reconcile Accounts window before, there 
are some special steps that you should perform before you begin the 
reconciliation process. If this is your situation, see �To reconcile an 
account for the first time using BusinessBasics� on page 353.

1. Enter or select the account you want to reconcile in the Account field, and 
press TAB.

2. Enter the ending balance that appears on your bank statement in the New 
Statement Balance field.

Note: Be sure to enter the ending balance!

Many bank statements have more than one balance on them. Be sure 
to enter the balance of your account at the end of the period.

3. Enter the closing date that appears on your bank statement in the Bank 
Statement Date field. Only unreconciled transactions dated on or before 
that date will appear in the scrolling list.

statements:reconciliation report

Note: Use care when entering the date in the Reconcile Accounts 
window

The Reconciliation Report enables you to view the status of an 
account's transactions as of a previous reconciliation date. If the 
bank statement date you enter in the Reconcile Accounts window is 
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different from the date that appears on the actual statement you 
received from your bank, you may find it difficult to determine which 
date should be used to print the Reconciliation Report in the future.

4. Click the Bank Entry button to open the Record Service Charges and 
Interest Earned window and enter any bank service charges you owe and 
any interest that you earned.

Skip to step 6 if you�ve already entered the bank charges and interest 
transactions in BusinessBasics before opening the Reconcile Accounts 
window. These transactions should already appear in the transactions list.

5. Click Record. If you need to record additional bank charges or fees, click 
the Bank Entry button again.

6. Mark each transaction in the scrolling list that appears on your bank 
statement. (Transactions entered using the Bank Entry feature are 
automatically marked as cleared.)

Note: You may edit, delete or reverse entries using this window

If the transaction information displayed in the Reconcile Accounts 
window is incorrect, you can choose to click the zoom to display the 
original transaction entry window. 

If your records are changeable, you may edit the transaction. When 
you click OK, the updated information will appear in the Reconcile 
Accounts window. If you choose Delete Transaction from the Edit 
menu to delete the transaction, the transaction will no longer appear 
in the Reconcile Accounts window.

If your records are unchangeable, you may reverse the transaction by 
choosing Reverse Transaction from the Edit menu. After a few 
moments, a new transaction, containing amounts exactly opposite to 
the original transaction, will be displayed. When you click Record, 
the reversal will be added to the Reconcile Accounts window. If you 
don�t want the original entry and the reversal to appear the next time 
you reconcile, mark both entries to indicate they are cleared. 

See �Choosing changeable or unchangeable transactions� on 
page 29 for more information.

7. Click the Reconcile button. A window appears, indicating whether your 
account is reconciled or is out of balance.
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8. If your account is reconciled, you can either reconcile the account or print 
the Reconciliation Report. 

To reconcile, click the Reconcile button; the transactions you marked are 
considered �cleared,� and won�t show up in the Reconcile Accounts 
window the next time you open it. To print the report, click Print Report; if 
you print the report, be sure to click Reconcile again to complete the 
reconciliation process after the report�s been printed.

Note: You must finish reconciling after you print the 
Reconciliation Report!

If you choose to print the Reconciliation Report, be sure to click the 
Reconcile button again in the Reconcile Accounts window. When 
you choose to print the report, the reconciling process is stopped, 
and you must click Reconcile again to complete the process.

4 To reconcile an account for the first time using 
BusinessBasics
reconciling:accounts:for the first time;accounts:reconciling:for the first time

Related topics 

�Reconciling an account for the first time� on page 342

1. Create a General Journal entry for the checking account, with a separate 
debit for each deposit that hasn�t cleared yet and a separate credit for each 
check that hasn�t cleared yet. 

2. It�s unlikely that the debits will equal the credits in the Record Journal 
Entry window. If the Out of Balance field underneath the scrolling list 
shows an amount, you�ll need to enter another line item with an amount 
that balances the debits and credits.

3. Click Record.

4. In the Checkbook Command Center, click Reconcile Accounts to open the 
Reconcile Accounts window.

5. Enter the account you want to reconcile in the Account field. The checks 
and deposits you�ve entered, as well as the individual line items in the 
General Journal entry you just created, appear in the scrolling list in the 
middle of the window.

6. Enter the ending balance on the statement that your bank sent you in the 
New Statement Balance field.
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7. Enter the closing date that appears on your bank statement in the Bank 
Statement Date field. Only the transactions dated on or before that date 
will appear in the scrolling list.

8. Mark all checks and deposits that are on your bank statement; also mark 
the balancing amount entry you created in step 2.

9. Click Reconcile. A window appears, indicating whether your account is 
reconciled or is out of balance.

10. If your account is reconciled, you can either reconcile the account or print 
the Reconciliation Report. 

11. Click Reconcile to reconcile the account. Click Print Report to print the 
report. If you print the report, be sure to click Reconcile again to complete 
the reconciliation process after the report�s been printed.

In future months, when you receive bank statements that contain the other 
transactions you performed before you began using BusinessBasics, you 
can mark off the other line items from the General Journal entry.
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C h a p t e r  6

Closing accounting 
periods
Closing accounting periods

4 To close an accounting period
accounting periods:closing;closing:accounting periods

Related topics 

�Closing accounting periods� on page 343

1. If you�ve received statements from your bank, use the Reconcile Accounts 
window to reconcile amounts in BusinessBasics with the amounts on the 
statements. See �To reconcile an account� on page 351 for more 
information about this task.

2. Print a Trial Balance (Detail) Report for the period. Check to see whether 
the activity that appears in the report is what you expected; for example, 
zero amounts in accounts that usually have regular activity may indicate a 
problem. See �To print a trial balance (or general ledger)� on page 344 for 
more information about this task.

3. If the information in the trial balance reports is acceptable, print the 
reports you want to keep as part of your permanent business records. 
Suggested reports include the balance sheet, profit and loss statement, 
Aged Payables Report, Aged Payables Report and all journal reports.

4. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records.
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Idea: Check your company file for errors before proceeding

To be completely sure that your company file is sound, we 
recommend that you use the BusinessBasics data verification feature 
before you continue. You can check your data for errors during the 
backup process, if you wish. For more information about data 
verification, see �Verifying company files� on page 74.

5. Choose Preferences from the Setup menu to open the Preferences window. 

6. Select the Security tab.

7. Change your selection in the Lock Periods list to the period you�re closing.
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